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FCC Statement

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This devicemay
not cause harmful interference, and (2) this devicemust accept any interference received, including interference that may
cause undesired operation. Changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate the equipment.

IC Statement

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two
conditions: (1) this devicemay not cause interference, and (2) this devicemust accept any interference, including interference
that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence.
L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de
l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le
fonctionnement.
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Using ExamView Test Player
This chapter covers the following topics:

Getting Started with the ExamView Test Player
Taking a Test with the Test Player
Navigating the Test
Test Player Button Controls
Going to a Specific Question/Checking for Unanswered Questions
Checking a Response
Playing a Multimedia Link
Answering Multiple Choice, True/False, Yes/No or Matching Questions
Answering Modified True/False Questions
Answering Multiple Response Questions
Answering Numeric Response Questions
Answering Completion Questions
Answering Short Answer, Problem, Essay, Case or Other Questions
Closing the Program

Getting Started with the ExamView Test Player
1 Launch the ExamView Test Player, enter your name and ID, and click Next.

Verify that you entered the information correctly or the test you wish to takemay not appear in the list of available tests.
If you do not know your ID number, consult your instructor.

2 Select a test and click Next.
If no tests appear in the list, click the Folder button and identify where the tests are located. Ask your instructor if you
need assistance with this step.

3 If prompted, enter a password and click Next.
If you do not know your password, consult your instructor.

4 Review the summary information and click Startwhen you are ready to begin.

NOTE
If you are resuming a test you had started in a previous session, you will automatically
continue where you left off. Answers and timer settings are automatically loaded with the
test.

Taking a Test with the Test Player
1 Answer the first question.

Themethod for answering questions will vary depending on the question type.
2 Move to the next question and answer it.

Repeat this step to answer all of the remaining questions. You can skip a question and come back to it later if
necessary. Use theGo ToQuestion button to see which questions you have not answered.
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NOTE
Youmay be able to check your work depending on how your instructor configured the test. If
a question has amultimedia link, you can play amovie, watch an animation, or listen to an
audio segment.

3 When you are finished with the test, click Test from themenu bar and select End Test, or click End.
Depending on how your instructor configured the test, youmay be given the option to save your answers and complete
the test at a later time. Select the appropriate option and click OK.

4 Depending on how your instructor configured the test, youmay be shown an end-of-test report. To print the report, click
File from themenu bar and select Print, click Print, or use the keyboard shortcut Ctrl+P (PC) orCmd+P (Mac).
ExamView Test Player prints the complete report or selected pages. The information on the report varies based on the
instructor’s configurations. Also, your instructor may choose to disable the print option.

5 To take another test, click File from themenu bar and select New or click New.
Once you complete a test, you can choose to take another test or you can close the program. If you choose to take
another test, youmust register again.

6 To close the program, click File from themenu bar and select Exit (PC) or click theExamView Test Playermenu and
select Quit ExamView Test Player (Mac) or click Exit.

Navigating the Test
1 Depending on the length of a question, youmay not be able to see the entire question in the display window. Using the

mouse, click the scroll bar to scroll the question. Using the keyboard, press the (Down Arrow) or (Up Arrow) to view the
entire question.

2 Navigating to another question can be done by using either themouse or the keyboard. The table below shows a
summary of the navigation buttons, keyboard shortcuts, and Test menu options for going to a different question.

To navigate to... Click Keyboard Shortcut Test MenuOption

a specific question
Ctrl+G (PC)

Cmd+G
Go ToQuestion...

the first question Ctrl+Page Up First Question

the previous question Page Up Previous Question

the next question Page Down Next Question

the last question Ctrl+Page Down Last Question

Test Player Button Controls
Most of the button functions are also accessible by usingmenu options or keyboard shortcuts.
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Test-taking Control Strip

Button Description Keyboard Menu

Open the program help file. --- Help > Help Topics

When active, this button allows you to check your
answer.

Ctrl+S (Win)

Cmd+S (Mac)
Test > Score
Question

Go to a different, specific question.
Ctrl+G (Win)

Cmd+G (Mac)
Test > Go To
Question...

End the test. --- Test > End Test

Play amultimedia link. This option is only available
whenmedia is associated with a question. --- ---

Question Navigation Strip

Button Description Keyboard Menu

Go to the first question. Ctrl+PAGE UP Test > First
Question

Go to the previous question. PAGE UP Test > Previous
Question

This option pauses the timer. This option is only present
if your instructor set a time limit for the test and chose to
allow you to pause the timer.

Ctrl+T (Win)

Cmd+T (Mac)
Test > Go To
Question...

Go to the next question. PAGE DOWN Test > Next
Question

Go to the last question. Ctrl+PAGE DOWN Test > Last
Question

Post-test Control Strip

Button Description Keyboard Menu

Open the program help file. --- Help > Help Topics
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Button Description Keyboard Menu

When available, this option Prints the end-of-test
report.

Ctrl+P (Win)

Cmd+P (Mac)
File > Print

Take a new test. --- File > New...

Close the program. ---

File > Exit (Win)

ExamView Test
Player > Quit
ExamView Test
Player (Mac)

Going to a Specific Question/Checking for Unanswered Questions
1 To navigate to a specific question, click Test from the

menu bar and select Go To Question or use the keyboard
shortcut Ctrl+G (PC) or Cmd+G (Mac), or click Go To.

2 A window with a preview list of all the questions in the test
appears.

NOTE
A red dot appears next to questions you
have not yet answered.

3 Highlight the desired question.
4 Click OK to display the selected question.

Checking a Response
Checking a response allows you to verify that your answer is correct and allows you to change your answer if it is incorrect.
This featuremay not be available depending on how your instructor set up the test. Once you exceed the limit for the number of
times you can check your work, this option is disabled and you cannot change your answer.

1 Click Score after you have answered the question.
You can also choose this option by clicking Test from themenu bar and selectingScore Question or using the
keyboard shortcut Ctrl+S (PC) or Cmd+S (Mac).
If you responded incorrectly, check your answer. For Completion questions, make sure that your response is spelled
correctly.

2 Click OK to continue.

Playing a Multimedia Link
If a question is attached to amovie, an animation, or a sound, ExamView Test Player displays theMedia button at the bottom
of the screen. Click this button to open a program that will let you play themultimedia link. Youmay have to start themedia by
clicking a Play button.
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1 After reading the question, click theMedia button to play themultimedia link.

NOTE
If the program displays amessage that it cannot find themultimedia link, try to identify the
location of the file (e.g., CD-ROM or DVD drive).

2 When themultimedia clip ends, click Close.

Answering Multiple Choice, True/False, Yes/No or Matching Questions
1 There are several methods to answer these types of questions. Youmay:

l Select the radio button next to the desired answer choice.

l Click the desired answer choice in theAnswer column.

l Type the letter of the answer choice on your keyboard.

2 Click or type a different choice to change your answer.
3 Click Score (if available) to check your answer. Or, click Next Question to move to the next question.

Answering Modified True/False Questions
A modified true/false question is similar to a standard true/false question in that youmust indicate if a sentence or phrase is
true or false. What distinguishes amodified true/false question is that youmust also change or edit the question if it is false to
make it true.

1 There are several methods to answer these types of questions. Youmay:
l Select the radio button next to the desired answer choice.
l Click the desired answer choice in theAnswer column.
l If the answer is false, enter text to replace the underlined portion of the question that will make the answer true in
the answer area. If the answer is true, leave the answer area blank.

NOTE
To enter a special character—such as a letter with an accent mark—in an answer, use the
appropriate keyboard shortcut.

2 Click or type a different choice to change your answer.
3 Click Score (if available) to check your answer. Or, click Next Question to move to the next question.

Answering Multiple Response Questions
1 There are several methods to answer these types of questions. Youmay:

l Select the radio button next to the desired answer choice.
l Click the desired answer choice in theAnswer column.
l Type the letter or letters of the answer choices on your keyboard.
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2 Click or type a different choice to change your answer.
3 Click Score (if available) to check your answer. Or, click Next Question to move to the next question.

Answering Numeric Response Questions
Themethod for answering numeric response questions varies depending on how your instructor set up your test.

1 If your instructor set up the question with a response grid, enter your answer on the grid. Youmay either key your
answer with your keyboard or click the appropriate numbered circles to create your answer.

2 If your instructor set up the question without a response grid, simply key your answer in the answer entry area.
3 To change your answer, use the backspace key to remove your answer. Then enter your new answer. If you clicked to

fill in a circle on a response grid, click the same circle again to erase it.
4 Click Score (if available) to check your answer. Or, click Next Question to move to the next question.

Answering Completion Questions
1 Type your answer in the answer entry area. Since these questions are automatically graded by the computer, pay extra

attention to be sure you spelled your response correctly.

NOTE
To enter a special character—such as a letter with an accent mark—in an answer, use the
appropriate keyboard shortcut.

2 To change your answer, use the backspace key to delete your answer. Then enter the new answer.
3 Click Score (if available) to check your answer. Or, click Next Question to move to the next question.

Answering Short Answer, Problem, Essay, Case or Other Questions
1 Type your answer in the answer entry area.

NOTE
To enter a special character—such as a letter with an accent mark—in an answer, use the
appropriate keyboard shortcut.

2 To change your answer, use the backspace key to delete your answer. Then enter the new answer.
3 Click Next Question to move to the next question.
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Closing the Program

NOTE
If you need to close the program before you complete a test, click File from themenu bar and
select Exit (PC) or click theExamView Test Playermenu and select Quit ExamView Test
Player (Mac). You will not see a report of your test results if you close the program without ending
the test.

1 Answer all of the questions on the test.
2 Click End.

Depending on how your instructor configured the test, youmay be given the option to save your answers and complete
the test at a later time. Select the appropriate option and click OK.

3 Click Exit to close the program.
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Keyboard Shortcuts

French
PC Mac

À Ctrl+` (ACCENT GRAVE) then Shift+A OPTION+` (ACCENT GRAVE) then Shift+A

Â Ctrl+^ (CARET) then Shift+A OPTION+I then Shift+A

Ä Ctrl+: (COLON) then Shift+A OPTION+U then Shift+A

Ç OPTION+Shift+C

È Ctrl+` (ACCENT GRAVE) then Shift+E OPTION+` (ACCENT GRAVE) then Shift+E

É Ctrl+' (APOSTROPHE) then Shift+E OPTION+E then Shift+E

Ê Ctrl+^ (CARET) then Shift+E OPTION+I then Shift+E

Ë Ctrl+: (COLON) then Shift+E OPTION+U then Shift+E

Ì Ctrl+` (ACCENT GRAVE) then Shift+I OPTION+` (ACCENT GRAVE) then Shift+I

Î Ctrl+^ (CARET) then Shift+I OPTION+I then Shift+I

Ï Ctrl+: (COLON) then Shift+I OPTION+U then Shift+I

Ò Ctrl+` (ACCENT GRAVE) then Shift+O OPTION+` (ACCENT GRAVE) then Shift+O

Ô Ctrl+^ (CARET) then Shift+O OPTION+I then Shift+O

Ö Ctrl+: (COLON) then Shift+O OPTION+U then Shift+O

Ù Ctrl+` (ACCENT GRAVE) then Shift+U OPTION+` (ACCENT GRAVE) then Shift+U

Û Ctrl+^ (CARET) then Shift+U OPTION+I then Shift+U

Ü Ctrl+: (COLON) then Shift+U OPTION+U then Shift+U

á Ctrl+` (ACCENT GRAVE) then A OPTION+` (ACCENT GRAVE) then A

â Ctrl+^ (CARET) then A OPTION+I then A

ä Ctrl+: (COLON) then A OPTION+U then A

ç OPTION+C

è Ctrl+` (ACCENT GRAVE) then E OPTION+` (ACCENT GRAVE) then E

é Ctrl+' (APOSTROPHE) then E OPTION+E then E

ê Ctrl+^ (CARET) then E OPTION+I then E

ë Ctrl+: (COLON) then E OPTION+U then E

ì Ctrl+` (ACCENT GRAVE) then I OPTION+` (ACCENT GRAVE) then I

î Ctrl+^ (CARET) then I OPTION+I then I

ï Ctrl+: (COLON) then I OPTION+U then I

ò Ctrl+` (ACCENT GRAVE) thenO OPTION+` (ACCENT GRAVE) thenO
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PC Mac

ô Ctrl+^ (CARET) thenO OPTION+I thenO

ö Ctrl+: (COLON) thenO OPTION+U thenO

ù Ctrl+` (ACCENT GRAVE) then U OPTION+` (ACCENT GRAVE) then U

û Ctrl+^ (CARET) then U OPTION+I then U

ü Ctrl+: (COLON) then U OPTION+U then U

German
PC Mac

Ä Ctrl+: (COLON) then Shift+A OPTION+U then Shift+A

É Ctrl+' (APOSTROPHE) then Shift+E OPTION+E then Shift+E

Ë Ctrl+: (COLON) then Shift+E OPTION+U then Shift+E

Ï Ctrl+: (COLON) then Shift+I OPTION+U then Shift+I

Ö Ctrl+: (COLON) then Shift+O OPTION+U then Shift+O

Ü Ctrl+: (COLON) then Shift+U OPTION+U then Shift+U

Ÿ Ctrl+: (COLON) then Shift+Y OPTION+U then Shift+Y

ß Ctrl+& then S OPTION+S

ä Ctrl+: (COLON) then A OPTION+U then A

é Ctrl+' (APOSTROPHE) then E OPTION+E then E

ë Ctrl+: (COLON) then E OPTION+U then E

ï Ctrl+: (COLON) then I OPTION+U then I

ö Ctrl+: (COLON) thenO OPTION+U thenO

ü Ctrl+: (COLON) then U OPTION+U then U

ÿ Ctrl+: (COLON) then Y OPTION+U then Y
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Haitian-Creole
PC Mac

À Ctrl+` (ACCENT GRAVE) then Shift+A OPTION+` (ACCENT GRAVE) then Shift+A

È Ctrl+` (ACCENT GRAVE) then Shift+E OPTION+` (ACCENT GRAVE) then Shift+E

Ò Ctrl+` (ACCENT GRAVE) then Shift+O OPTION+` (ACCENT GRAVE) then Shift+O

á Ctrl+` (ACCENT GRAVE) then A OPTION+` (ACCENT GRAVE) then A

è Ctrl+` (ACCENT GRAVE) then E OPTION+` (ACCENT GRAVE) then E

ò Ctrl+` (ACCENT GRAVE) thenO OPTION+` (ACCENT GRAVE) thenO

Spanish
PC Mac

¡ ALT+Ctrl+! OPTION+!

¿ ALT+Ctrl+? OPTION+?

Á Ctrl+' (APOSTROPHE) then Shift+A OPTION+E then Shift+A

É Ctrl+' (APOSTROPHE) then Shift+E OPTION+E then Shift+E

Í Ctrl+' (APOSTROPHE) then Shift+I OPTION+E then Shift+I

Ñ OPTION+N then Shift+N

Ó Ctrl+' (APOSTROPHE) then Shift+O OPTION+E then Shift+O

Ú Ctrl+' (APOSTROPHE) then Shift+U OPTION+E then Shift+U

Ü Ctrl+: (COLON) then Shift+U OPTION+U then Shift+U

á Ctrl+` (ACCENT GRAVE) then A OPTION+` (ACCENT GRAVE) then A

é Ctrl+' (APOSTROPHE) then E OPTION+E then E

ì Ctrl+` (ACCENT GRAVE) then I OPTION+` (ACCENT GRAVE) then I

ñ OPTION+N then N

ò Ctrl+` (ACCENT GRAVE) thenO OPTION+` (ACCENT GRAVE) thenO

ù Ctrl+` (ACCENT GRAVE) then U OPTION+` (ACCENT GRAVE) then U

ü Ctrl+: (COLON) then U OPTION+U then U
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Troubleshooting Tips
After I enter my name and ID, my test does not appear in the list.

Click the Folder button to identify the location of the tests. If you still cannot see your test, check with your instructor to verify
that you are part of the roster, that your ID is correct, and that the test has not expired.

I don't have time to finishmy test, and there is no option to save.

Your instructor has the option to turn on or off the ability to save and resume a test. Click End to end your test. If you do not see
the option to save your test, your instructor has not enabled this option.

When I click theMedia button, nothing happens.

Sometimes, amedia player may not appear on top of the test window. Check the Taskbar to see if another application is
running. If so, click it to display the window.



ExamView Test Player 15

Contact Us
For additional help, contact Turning Technologies Technical Support.

Technical Support is available from 8 a.m. - 9 p.m. EST.

From within the contiguous United States, you can reach Technical Support toll-free by calling 866.746.3015. If you are calling
from outside of the United States, please call +1 330.746.3015.

A technical support case can be created at support.turningtechnologies.com .

Office Locations

Ohio

255West Federal Street
Youngstown, Ohio 44503
Toll-Free: 866.746.3015
Direct: 330.746.3015
International: +1 330.746.3015

Belfast

19 Colvin House
Inspire Business Park
Carrowreagh Road
Belfast BT16 1QT
United Kingdom
Direct: +44 (0)28 9048 7898

Amsterdam

Keizersgracht 75, Garden
1015 CE, Amsterdam
TheNetherlands
Direct: +31 (0)85 4011 040

http://support.turningtechnologies.com/

	Contents
	Using ExamView Test Player
	Getting Started with the ExamView Test Player
	Taking a Test with the Test Player
	Navigating the Test
	Test Player Button Controls
	Going to a Specific Question/Checking for Unanswered Questions
	Checking a Response
	Playing a Multimedia Link
	Answering Multiple Choice, True/False, Yes/No or Matching Questions
	Answering Modified True/False Questions
	Answering Multiple Response Questions
	Answering Numeric Response Questions
	Answering Completion Questions
	Answering Short Answer, Problem, Essay, Case or Other Questions
	Closing the Program

	Keyboard Shortcuts
	French
	German
	Haitian-Creole
	Spanish

	Troubleshooting Tips
	Contact Us

